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Introduction
Cisco WAN Automation Engine (WAE) provides the tools to create and maintain a model of the current 
network through the continual monitoring and analysis of the network and the traffic demands that are 
placed on it. This network model contains all relevant information about a network at a given time, 
including topology, configuration, and traffic information. You can use this information as a basis for 
analyzing the impact on the network due to changes in traffic demands, paths, node and link failures, 
network optimizations, or other changes.

The WAE platform is an open, programmable framework that interconnects software modules, 
communicates with the network, and provides APIs to interface with external applications.
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New Features
Note To find related WAE documentation, see the Cisco WAE 7.1 Documentation Roadmap.

New Features
This section lists new features for the following:

• WAE Platform and System

• WAE Design

• Cisco WAE Live

• Cisco WAE Coordinated Maintenance

• CLI Changes

• YANG Data Model

• New APIs

WAE Platform and System
A YANG model architecture and new network model building workflow has been introduced in Cisco 
WAE 7.1. Network models are built from configuring Network Interface Modules (NIMOs) instead of 
using the snapshot collection process used in prior WAE 6.x releases. For these reasons, all tools and 
procedures are new. To learn how to use WAE 7.1, see the Cisco WAE 7.1 User Guide.

The following table outlines some of the new features in WAE 7.1.

Feature Description

Easier installation Installation is simpler and faster than previous WAE releases.

Support for the YANG 
data model

WAE 7.1 adopts the YANG data modeling language for its configuration and operational data 
structure. In addition, WAE 7.1 provides a standard northbound API based on NETCONF/YANG 
and REST. See YANG Data Model, page 15.

Redesigned WAE UI The WAE UI has been redesigned. There are three available interfaces: WAE CLI, WAE Expert 
Mode, and the WAE UI. For more information, see the "Overview" section in the Cisco WAE 7.1 
User Guide.

Network interface 
modules (NIMOs)

The network model is a result of running NIMOs. Each NIMO is associated with one network model 
(which is similar to the -plan-file option in CLI tools). Each NIMO typically has a source and the 
resulting output is written to the network model (which is similar to the -out-file option in CLI 
tools).

The output of one NIMO can be used as a source for another NIMO. Consolidation of multiple 
NIMOs is done using an aggregator.
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Agents Agents are collections that produce a raw set of data output, which is then used as input to NIMOs 
to build the network model.

• xtc—Connects to the REST interface of the XR Transport Controller (XTC) and retrieves the 
PCE topology. The topo-bgpls-xtc-nimo and lsp-pcep-xtc-nimo modules use the raw output to 
build their respective network model.

• cfg-parse—Retrieves the router configurations through login or CLI, and then parses the router 
configurations and writes raw output to the database. The port-cfg-parse-nimo module uses the 
raw output for Layer 1 collection.

WAE Modeling 
Daemon (WMD)

WMD provides a near real-time representation (model) of the network in memory so that 
applications can get access to that model. For more information, see the "Overview" chapter in the 
Cisco WAE User Guide.

Bandwidth on Demand 
application

The Bandwidth on Demand (BWoD) application utilizes the near real-time model of the network 
offered by WMD to compute and maintain paths for SR policies with bandwidth constraints 
delegated to WAE from XTC. In order to compute the shortest path available for a SR policy with 
a bandwidth constraint and ensure that path will be free of congestion, a Path Computation Element 
(PCE) must be aware of traffic loading on the network. The WAE BWoD application extends the 
existing topology-aware PCE capabilities of XTC by allowing delegation of bandwidth-aware path 
computation ofSR policiesto be sub-delegated to WAE through a new XTC REST API. Users may 
fine-tune the behavior of the BWoD application, affecting the path it computes, through selection 
of application options including network utilization threshold (definition of congestion) and path 
optimization criteria preferences.

Bandwidth 
Optimization 
application

The Bandwidth Optimization application is an approach to managing network traffic that focuses 
on deploying a small number of LSPs to achieve a specific outcome in the network. Examples of 
this type of tactical traffic engineering are deploying LSPs to shift traffic away from a congested 
link, establishing a low-latency LSP for priority voice or video traffic, or deploying LSPs to avoid 
certain nodes or links. WAE provides the Bandwidth Optimization application to react and manage 
traffic as the state of the network changes.

Support for NSO 
layered service 
architecture (LSA)

The basic idea of LSA is to split a service into an upper layer and one or several lower level parts. 
This can be viewed as splitting the service into a customer-facing (CFS) and a resource-facing 
(RFS) part. The CFS code (upper-level) runs in one (or several) NSO cfs-nodes, and the RFS code 
(lower-level) runs in one of many NSO rfs-nodes. The rfs-nodes have each a portion of the managed 
devices mounted in their / devices tree and the cfs-nodes have the NSO rfs-nodes mounted in their 
/devices tree. For more information on NSO LSA, see the NSO Layered Service Architecture guide. 
For information on how to configure LSA for WAE, see the "WAE Administration" chapter in the 
Cisco WAE User Guide.

Feature Description
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WAE Design
The following features have been added or updated since WAE Design 6.4.x. For the latest WAE Design 
documentation, see the following URL: 
https://www.cisco.com/c/en/us/support/routers/quantum-wan-automation-visibility-engine/products-us
er-guide-list.html

Multi-layer collection Multi-layer collection is supported. WAE collects and models the following information:

• Topologies from DWDM networks that support Generalized Multiprotocol Label Switching 
(GMPLS) with non-User Network Interface (UNI) circuits

• L1 circuit paths

• L1 topology with and without amplifiers

• Unprotected and restorable paths

• Actual L1 circuit path hops

• Feasibility metrics and limits

• Inactive L1 links

• L1 node and L1 link SRLGs

• Site information

• User properties

• Configurable Lambda ID mapping options

• Aging information and last seen date

For more information, see the "Multi-Layer Collection" chapter in the Cisco WAE User Guide.

NetFlow data collection Centralized and distributed NetFlow collection is supported using the external-executable-nimo.

For more information, see the "NetFlow Data Collection" chapter in the Cisco WAE User Guide.

Deprecated CLIs The following CLI options are deprecated:

• -use-mate-convert-on-input-plan-files

• -use-resolve-plan-on-closing

If the plan file ends in .pln or .txt, it is converted automatically; the CLI option is no longer required.

Feature Description
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New Features
Feature Description

Easier way to send patch files to WAE The Send Patch dialog box provides the option to dry run a patch before deploying it. 
(Check Dry Run or set the Test Option to Test Only.) If the patch dry run succeeds, 
you can deploy the patch easily. (Click Send Patch in the status popup; return to the 
Send Patch dialog box with the patch preselected.)

SR TE Optimization tool 
enhancements

• SR TE Optimization tool now creates or optimizes segment lists so they avoid 
routing through specified objects (nodes, interfaces, L1 links, L1 nodes, or 
SRLGs). In previous releases, only the avoidance of nodes was supported. For 
example, if an L1 link is specified to be avoided, then all L3 circuits associated 
(directly or indirectly via port circuits) to L1 circuits using this L1 link will be 
avoided. Multiple avoidance constraints may be simultaneously specified.

The following UI options are available under the Constraints area (SR LSP 
Optimization > SR-TE Opt):

– Nodes

– Interfaces

– L1 Links 

– L1 Nodes 

– SRLGs   

• The SR TE Optimization tool allows for rerouting of existing LSPs. New 
rerouting LSP options available in the UI (SR LSP Optimization > SR-TE BW 
Opt > Analysis and SR LSP Optimization > SR-TE BW Opt > Analysis).

Under LSPs:

– Create new LSPs—If checked, new private SR LSPs with optimized routing 
can be created. If unchecked, new LSPs are not created.

– Fix LSPs—Controls whether or not LSP routes can be modified. This 
constraint is useful if you want to reroute existing LSPs to mitigate 
congestion.

The new CLI options are described in the New CLI Options section.

Improvements to the Tools menu The Tools menu has been restructured by protocol.

For example, the various Optimization options under the Tools menu have submenus 
that are based on common protocols.

Improvements to the View > 
Preferences dialog box

The View Preferences dialog box has these enhancements:

• New scaling options for objects and fonts. Circuit and link widths in layouts are 
scaled according to the scale factors in the network plot. The valid range, in 
percentages, for scale factors is from 5 to 1000.

• The option to choose a grey or multicolored palette for background maps in 
geographic layouts.

• The option to choose a grey or white background for schematic plots.

• A Reset button that lets you reset preferences to the default.

Option to plot P2MP LSPs You can plot the routes of point-to-multipoint (P2MP) LSPs in a separate plot.
5
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Option to optimize the routing of L1 
circuit paths

You can optimize the routing of L1 circuit paths by metric, delay, distance, or hop 
count. The L1 Circuit Path Optimization tool lets you find the shortest path while 
meeting disjointness requirements. You can find the shortest path with respect to:

• L1 link metric

• Delay of the L1 link

• Distance of the L1 link

• Hop count

Addition of unresolved hops for 
segment list hops

WAE Design allows unresolved hops to be stored for each segment list hop.

Option to compress segment lists You can specify the maximum segment list length for specific LSPs. Any segment lists 
that exceed the maximum length are replaced by new LSPs, LSP paths, and segment 
lists. Newly created LSPs are set as segment list hops for other LSPs.

Option to visualize SID values on 
interfaces

You can configure the appearance of circuits and interfaces in network plots. You can 
choose to display the SID value as the interface text.

Option to show or hide L1 nodes in 
network plots

By default, L1 nodes are visible in the network plot. You can hide L1 nodes and their 
respective L1 links on a per-layout basis, though they still exist in the plan file and 
tables.

Option to set and position the display 
name of L1 nodes in network plots

By default, L1 node names appear above the object in a network plot; you can change 
this positioning.

Easier way of deleting associated L1 
circuits or L1 ports

When you delete objects from link aggregation groups (LAGs), you have the option 
to delete any associated L1 circuits and L1 ports.

• When you delete a circuit, you can check the Delete associated L1 circuit(s) 
check box.

• When you delete a port circuit, you can check the Delete associated L1 circuit(s) 
check box. 

• When you delete an L1 circuit, you can check the Delete associated L1 port(s) 
check box.

Enhanced support for inter-AS LSPs Simulation now supports inter-AS RSVP LSPs. Also, the following tools now support 
inter-AS RSVP LSPs:

• RSVP-TE Optimization (Tools > RSVP LSP Optimization > RSVP-TE Opt)

• LSP Disjoint Path Optimization (Tools > LSP Optimization > LSP Disjoint 
Path Opt)

Option to edit patches before sending 
them

You can edit a patch before sending it. To do this, choose Tools > Patches > View, 
open a patch file, and click Edit Patch. A dialog box opens, displaying the contents 
of the patch as XML text.

You can save or discard the patch text edits. The tool warns you if you try to save 
invalid XML syntax. You can right-click in the patch text dialog and choose Undo to 
undo changes. Other standard text editing (cut, copy, paste, and so on) is also 
supported.

Feature Description
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Option to visualize L1 paths when 
plotting demands, LSPs, LSP paths, 
or P2MP LSPs

You can easily visualize multilayer L1 paths when plotting demands, LSPs, LSP 
paths, or P2MP LSPs. For example, in a complicated plot you can easily verify 
whether two LSPs are disjoint in terms of L1 links.

To visualize L1 paths, do any of the following:

• Right-click a demand and choose Plot Demands

• Right-click an LSP and choose Plot LSPs

• Right-click an LSP path and choose Plot LSP Paths

• Right-click a P2MP LSP and choose Plot P2MP LSPs

The plot window contains a drop-down list with the following options:

• L3—Displays the path in terms of interfaces.

• L1—Displays the path in terms of L1 links.

– To better align the L1 links, WAE Design checks for L3-L1 links. If they do 
not exist, WAE Design checks for collocated L3/L1 nodes within sites.

• L3+L1—Displays the L3 plot above and the L1 plot below.

– WAE Design does not perform alignment between L3 and L1 nodes. When 
you click an L3 interface, the associated L1 links are highlighted 
automatically.

Update to WAE Design system 
requirements

For more information, see the "Cisco WAE Installation Requirements" chapter in the 
Cisco WAE Installation Guide.

Option to associate an existing 
demand to an existing private LSP

If a demand is associated with a private LSP, the demand can only route through that 
LSP, and the only demand that is permitted to cross that LSP is this demand.

In the demand’s Properties dialog box, you can associate an existing demand to an 
existing private LSP. (To open the Properties dialog box, right-click the demand and 
choose Properties.) The Private LSP drop-down list shows the private LSP that is 
currently associated with the selected demand. You can choose a different private LSP, 
or you can choose None to remove an associated LSP.

The following new features are not included in the latest WAE Design release documentation:

L1 feasibility simulation calculation 
enhancement

L1 feasibility calculations now consider unidirectional parameters for L1 links (noise 
and noise sigma) and a margin for L1 circuits.

Capacity Planning Optimization tool 
enhancement

The Capacity Planning Optimization tool now accounts for costs and different 
capacity increments. The CLI options are described in the New CLI Options section.

Demand Deduction calculation 
enhancement

There is a new option that (through different calculation methods) can minimize 
computation time. The CLI option is described in the New CLI Options section. 

Feature Description
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Option to report the L1 circuit paths 
through an L1 node

You can determine the number of L1 circuit paths through an L1 node under normal 
operation and in a worst-case simulation.

The L1 Nodes table includes new columns:

• Num L1 Circuit Paths—Number of L1 circuit paths with paths through the L1 
node.

• WC Num L1 Circuit Paths—Worst-case number of L1 circuit paths with paths 
through the L1 node.

• WC Failures—Failures that cause the worst-case number of L1 circuit paths.

The L1 Nodes context menu includes a new option: Fail to WC (worst case).

Option to see if an L1 node is shown 
in the current layout

The L1 Nodes table contains a new "Shown" column with values of true or false:

• T (true)—The L1 node is shown in the current layout.

• F (false)—The L1 node is not shown in the current layout.

Option to configure the number of 
route attempts on L1 paths

In earlier WAE Design releases, the number of attempted routes for L1 circuit paths 
was set to 5. 

In WAE Design 7.1 you can configure the number of attempted routes for L1 circuit 
paths. Increasing the number of attempted routes allows for more paths to be explored, 
thereby potentially reducing the number of unrouted L1 circuits. This increases the 
overall computation time. To configure the number of route attempts, choose Edit > 
Network Options and set the Number of Attempts to Route L1 Circuit Paths 
parameter.

Option to expand and collapse sites 
per layout

You can group nodes and sites and build a hierarchy of sites. 

In earlier WAE Design releases, site memberships were fixed for all layouts, per plan 
file: You could only have one set of site groups, which you had to visualize in the same 
way.

In WAE Design 7.1 you can expand or collapse a site per layout. You can control the 
level of detail shown in individual layouts. You can collapse down to the node level at 
one site, but still keep other sites intact. For example, one layout could have "France" 
as the main focus, and other regions could be collapsed (U.S. sites grouped together 
under a single "USA" site). Another layout could have the opposite display: U.S. sites 
expanded, and the "France" site collapsed.

To expand or collapse sites per layout, right-click a site and choose Layout > Expand 
Site or Layout > Collapse Site.

When a site is expanded, its contents are shown (instead of the site itself). When a site 
is collapsed, the site itself is shown. This feature allows you to better scale a plot that 
contains many objects.

Option to ignore SSL errors in the 
Open/Save and from/to Design 
Archive dialog boxes

• T (true)—SSL errors are treated as warnings and server connections are allowed.

• F (false)—A dialog box appears with information about the error and the user is 
given the option to proceed with the server connection. This is the default.

Feature Description
8
Cisco WAN Automation Engine Release Notes, Release 7.1



   

New Features
Figure 1 WAE Design Simulation Analysis Report

Overview of Inter-AS and Inter-Area Support

The following table shows which WAE Design tools support inter-area and inter-AS functionality.

Option to open plan file from WMD File > Open From > WAE Modeling Daemon

There is also an new icon on the Toolbar that can be used to open a plan file from 
WMD.

Improved display of the Simulation 
Analysis report

When you choose Tools > Simulation Analysis and run the analysis, the resulting 
report (Figure 1) shows:

• Results displayed in table format for ease of use

• Violations in red

• Successes in green

Feature Description

Tool Supports Inter-Area? Supports Inter-AS?

SR-TE Optimization Yes Yes

SR-TE Bandwidth Optimization Yes No

RSVP-TE Optimization Yes Yes

LSP Disjoint Path Optimization Yes Yes

Explicit LSP Paths Initializer RSVP only (in terms of 
ABR hop creation)

No

Explicit P2MP LSP Paths Initializer Yes No

Explicit LSP Optimization Yes No
9
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WAE Design Schema

Refer to the /opt/cariden/software/mate/current/docs/table_schema.html file for a complete reference.

Cisco WAE Live
The following features have been added or updated since WAE Live 6.4.x. For information on how to 
use WAE Live, see the Cisco WAE 6.4 Administration Guide and the Cisco WAE 6.4.1 User Guide.

Cisco WAE Coordinated Maintenance
The installation steps for WAE Coordinated Maintenance has changed. For installation information, see 
the Cisco WAE 7.1 Installation Guide. For information on how to use WAE Coordinated Maintenance, 
see the Cisco WAE Coordinated Maintenance 1.2 User and Administration Guide.

CLI Changes
WAE CLI tools are located in <wae-installation-directory>/bin. For available CLI options and 
descriptions, execute the CLI tool with the -help option. If WAE Design is installed, the WAE Design 
CLI tools are located in /opt/cariden/software/mate/current/bin.

Feature Description

WAE Live installation There are a few WAE Live installation changes which include the following:

• WAE Live must be installed on a different machine than where the WAE 7.1 server software is 
installed. 

• If you have not used WAE Live on the system before, the default password for the user admin 
is "admin". 

• Updated WAE Live data store migration steps.

For more information on installation, data migration, and system requirements, see the Cisco WAE 
7.1 Installation Guide.

Collect plan files from 
the WAE 7.1 server

From  Settings > Data Source, select the 7.1 Remote Archive radio button and enter the WAE 7.1 
server details.

Changes to WAE Live 
UI components 

The following UI components have been removed:

• System > User Access

• System > Log Settings

• Home > WAE Statistics

The Database Info component has been moved under Home.
10
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New CLI Tools 

The following table describes new CLI tools in WAE 7.1.

New CLI Options

The following table describes new CLI options in WAE 7.1.

CLI Tool Description

WAE Design

compress_segment_lists Lets you specify the maximum segment list length for specific LSPs.

l1_circuit_path_opt Optimizes the routing of L1 circuit paths by minimizing path length and respecting disjoint 
path requirements.

send_patch Sends a patch file to WAE, applying it to the specified WAE network. The connection is 
made through SSH. If SSH keys cannot be used for authentication, you are prompted for a 
password.

wae_get_plan Gets a network plan file from WAE. The connection is made through SSH. If SSH keys 
cannot be used for authentication, you are prompted for a password.

CLI Option Description

capacity_planning_opt

-opt-objective The optimization objective. It can be set to one of the following:

• cap (the default)—The optimization objective is set to the minimization of total added 
capacity.

• cost—The optimization objective is set to the minimization of total cost.

-bw-increment-options Table with options on allowed capacity increments. The following are allowed columns 
in the Costs table: 

• Capacity

• L3PortCost

• L1PortCost

• FeasibilityLimit

The default is empty. This option is ignored if the -opt-objective is set to "cap".

compress_segment_lists

-lsps-table Optimize LSP paths of LSPs in the -lsps-table with segment lists that exceed the 
-max-sl-length. The default is "all."

-max-sl-length The maximum length of segment lists associated with LSP paths of LSPs in the 
-lsps-table. The length must be at least 3; the default is 9.

-remove-orphaned-sls If true (the default), remove segment lists that are not used by other LSP paths or SR FRRs 
as a result of the optimization. If false, do not remove orphaned segment lists.

-lsp-tag Tag with this value any newly created and updated LSPs. The default is SLOpt.

dmd_deduct_tool
11
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-computation-time The computation time of the dmd_tool may be reduced by selecting one of the following 
values: 10 (the default), 20, 30, 40. Higher values aim to reduce computation time.

l1_circuit_path_opt

-l1-circuit-paths-table A file containing <L1CircuitPaths> table of L1 circuit paths to optimize. The default is 
"all."

-path-metric The path length that the optimizer tries to minimize. Values are:

• metric—(the default) Use L1 link metric.

• delay—Use L1 link delay.

• distance—Use L1 link distance.

• hops—Use hop count.

-disjoint-path-constraints Values are:

• None—(the default) Impose no disjoint path constraints.

• DisjointGroups—Create disjoint L1 circuit paths between L1 circuits in  disjoint 
groups.

• PrimSec—Create disjoint primary and secondary paths for L1 circuits.

-existing-hops If set to “remove” (the default), existing L1 circuit path hops and actual L1 circuit path 
hops are removed. If set to “respect,” existing hops are respected.

-strict-l1link-priority The priority of L1 link disjointness. Values are ignore, 1 (the default), 2, or 3.

-strict-l1node-priority The priority of L1 node disjointness. Values are ignore (the default), 1, 2, or 3.

-strict-site-priority The priority of site disjointness. Values are ignore (the default), 1, 2, or 3.

-strict-SRLG-priority The priority of SRLG disjointness. Values are ignore (the default), 1, 2, or 3.

-l1-circuit-path-tag Tag with this value any L1 circuit paths whose L1 circuit path hops have been updated. 
The default is L1Opt.

mate_plot

-uniform-scaling If true (the default), objects and fonts are uniformly scaled based on the -scale-objects 
option. If false, objects and fonts are scaled based on the -scale-l3-l1-nodes, 
-scale-circuits-l1-links, and scale-fonts options.

-scale-l3-l1-nodes Relative size of L3 nodes and L1 nodes with respect to their size, in pixels, in the network 
plot (assuming the default to be View Preferences). The default is 100. Ignored if 
-uniform-scaling is set to true.

-scale-circuits-l1-links Relative size of circuits and L1 links with respect to their size, in pixels, in the network 
plot (assuming the default to be View Preferences). The default is 100. Ignored if 
-uniform-scaling is set to true.

-scale-fonts Relative size of fonts with respect to their size, in pixels, in the network plot (assuming 
the default to be View Preferences). The default is 100. Ignored if -uniform-scaling is set 
to true.

-map-palette The color palette for the background map in Geographic layouts. Values are:

• grey—(the default) Grey palette is used for background maps.

• multi-color—Multi-color palette is used for background maps.

-icons If true, the L3/L1 node and site icons are used for Design plot layouts. The default is false.

CLI Option Description
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-scale-objects <percentage> Relative size of objects (sites, nodes, circuits, L1 nodes, L1 links, fonts) with respect to 
their size, in pixels, in the network plot (assuming the default to be View Preferences). 
The default is 100. Ignored if -uniform-scaling is set to false.

resolve_plan

-segment-lists If true (the default), resolve all segment list hops.

For segment list hops, WAE tries to match the IP address or SID in the NetIntHop column 
to a node, interface, anycast group, or LSP in the following order of priority:

1. SID/IP entry in the Nodes table. If there are multiple matches, WAE chooses the 
lowest one and generates a warning.

2. SID/IP entry in the Interfaces table, where the node associated to the interface is the 
node corresponding to the previous hop (or to the LSP source node if this is the first 
hop). If the previous hop is an interface hop, the remote node of the interface is 
considered.

3. SID entry in the Anycast Groups table.

4. SID entry in the LSPs table.

send_patch

-help <true/false> Prints the help message.

-options-file <value> Reads options from <filename>.

-version <true/false> Prints the version string.

-no-global-options 
<true/false>

Prevents loading the global options file.

-suppress-progress 
<true/false> 

Determines whether to suppress progress information. The default is true.

-verbosity <value> Log verbosity, from 1 (lowest) to 60 (highest). The default is 30.

-log-file <value> Copies of warnings and errors are saved in this file.

-simple-txt-out-file 
<true/false>

Determines whether to remove empty tables and columns from .txt format of -out-file if 
the parameter exists. The default is false.

-patch-file <value> Input patch file that contains the patch to apply.

-wae-host <value>: WAE server hostname. The default is localhost.

-wae-port <value>: WAE server port. The default is 22.

-wae-user <value> WAE user to log in as. The default is the current user.

-authGroup 
<AuthServerGroupName>

AuthServerGroupName specified in the authentication file used to read the credentials.

-auth-file <filename> Authentication filename. The default is in the configuration path: $HOME/.cariden/etc, 
$CARIDEN_ROOT/etc, or $CARIDEN_HOME/etc. The default is auth.enc.

-dry-run <true/false> If specified, do not apply the patch. Perform a dry-run instead, and return a message 
detailing what configuration changes would be implemented if the patch was applied. The 
default is false.

-reply-out-file <value> Write the WAE reply to this file. If empty (the default), the reply is written to standard 
output.

-network-name <value> WAE network to apply the patch. Overrides the name specified in the patch file. This 
option is required if the patch does not specify a network name.

CLI Option Description
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New Features
New APIs
The following table describes new API features. WAE Design API documentation is located in 
$CARIDEN_HOME/docs/api/design.

-test-option <value> Test option: test-then-set (the default) or test-only.

-error-option <value> What to do in case of an error. Valid values are rollback-on-error (the default), 
stop-on-error, and continue-on-error.

sr_te_bw_opt

-fix-lsps-table SR LSPs in the table should not be rerouted. The default is "all."

-create-lsps If true (the default), new private SR LSPs with optimized routings can be created. If false, 
new LSPs cannot be created.

-create-adj-segment-hops If false (the default), only node segment hops are created. If true, interface segment hops 
(adjacency hops) can be created.

sr_te_opt

-avoid-interfaces-table Creates segment list entries that route away from any interfaces. The default is none. 

-avoid-l1-links-table Creates segment list entries that route away from any L1 links. The default is none. 

-avoid-l1-nodes-table Creates segment list entries that route away from any L1 nodes. The default is none.

-avoid-srlgs-table Creates segment list entries that route away from any SRLGs. The default is none.

wae_get_plan

-help <true/false> Prints the help message.

-options-file <value> Reads options from <filename>.

-version <true/false> Prints the version string.

-no-global-options 
<true/false>

Prevents loading the global options file.

-suppress-progress 
<true/false> 

Determines whether to suppress progress information. The default is true.

-verbosity <value> Log verbosity, from 1 (lowest) to 60 (highest). The default is 30.

-log-file <value> Copies of warnings and errors are saved in this file.

-simple-txt-out-file 
<true/false>

Determines whether to remove empty tables and columns from .txt format of -out-file if 
the parameter exists. The default is false.

-out-file <value> Output plan file from WAE.

-network-name <value> WAE network for the plan file.

-wae-host <value> WAE server hostname. The default is localhost.

-wae-port <value> WAE server port. The default is 22.

-wae-user <value> WAE user to log in as. The default is the current user.

CLI Option Description
14
Cisco WAN Automation Engine Release Notes, Release 7.1



   

Documentation
YANG Data Model
WAE 7.1 adopts the YANG data modeling language for its configuration and operational data structures. 
In addition, WAE 7.1 provides a standard northbound API based on NETCONF/YANG and REST.

YANG is a data modeling language used to describe configuration and operational data, remote 
procedure calls, and notifications for network devices. The salient features of YANG are:

• Human-readable format, easy to learn and represent

• Supports definition of operations

• Reusable types and groupings

• Data modularity through modules and submodules

• Supports the definition of operations (RPCs)

• Well-defined versioning rules

• Extensibility through augmentation

For details about YANG, refer to RFC 6020 and 6087

Documentation
To find descriptions of all related Cisco WAE documentation, see the Cisco WAE 7.1 Documentation 
Roadmap.

Feature Description

WAE Design APIs

getplan Lets you connect to a WAE 7.0 instance through a RESTCONF API call and get back a byte stream 
that contains the plan file.

resolve_plan Lets you resolve differences in plan files that have configurations that are not matched or refer to 
objects outside the modeled network. The ability to resolve plan file differences is helpful when 
routing SR LSPs whose source and destination nodes are in different autonomous systems.

send_patch Lets you send a patch in .xml format; a NETCONF RPC is sent in response. You can generate a dry 
run of the patch to test its validity before sending it. You can roll back the patch in case of an error.

WAE OPM API

OPM API Optimization and prediction modules (OPMs) provide a powerful Python API to manipulate network 
models. The OPM API lets you operate on the network without having to worry about 
device-specific properties. Even if the underlying routers are replaced by routers from a different 
vendor, the API calls remain exactly the same.

The OPM APIs provide powerful what-if capabilities. For example, the OPM APIs let you answer 
the following questions:

• What is the impact if I bring this router down for maintenance?

• What happens if I increase the capacity of this circuit?

• Can my network handle a data center backup now?
15
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Open Bugs
Note We sometimes update the documentation after original publication. Therefore, you should always review 
the documentation on Cisco.com for any updates.

Documentation Changes
• The Cisco WAE Platform Configuration Guide and the Cisco WAE System Administration Guide are 

deprecated; content is available in the new Cisco WAE User Guide. 

• The Cisco WAE Server Installation Guide has been renamed to Cisco WAE Installation Guide. It 
includes system requirements and procedures for installing WAE Live and WAE Coordinated 
Maintenance.

Open Source
A list of open source software that is used in WAE can be found in Open Source Software Used in Cisco 
WAN Automation Engine.

Open Bugs
The following are descriptions of the resolved bugs in Cisco WAE Release 7.1. The bug IDs link you to 
the Cisco Bug Search tool.

Table 1 Open Bugs

Bug ID Description

CSCvg80478 The URL redirect from HTTP port 8080 to 8443 fails. 

Workaround:

Manually enter https://<ip_address>:8443.

CSCvg83828 LSP collection using NSO NEDs (lsp-config-nimo) does not collect named path hops due to an out of sync 
error.

CSCvh50411 Running the same external-executable-nimo more than once fails.

CSCvh20528 Sometimes WAE processes stop when the XATP module is disabled.

Workaround: 

Issue the following commands in sequence and perform a commit after each step:

1. wae components bw-on-demand config enable false 

2. wae components xatp config enable false 

3. wae components wmd config enable false 

4. wae agents xtc xtc <network_name> disable xtc-host-ip <XTC_IP> 

CSCvh50648 The XTC Agent to Patch (XATP) module sends a patch that is not converted correctly when merged with 
the patch into WMD.

CSCvh52238 WMD starts even if it is disabled in the WAE configuration file. This occurs after loading a WAE 
configuration file where the WMD enable value is set to ’false’.
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Using the Cisco Bug Search Tool
Using the Cisco Bug Search Tool
You can use the Cisco Bug Search Tool to search for a specific bug or to search for all bugs in a release.

Step 1 Go to the Cisco Bug Search Tool.

Step 2 Enter your registered Cisco.com username and password, and click Log In. 

The Bug Search page opens.

Note If you do not have a Cisco.com username and password, you can register here.

Step 3 Use any of these options to search for bugs, and then press Enter (Return) to initiate the search:

• To search for a specific bug, enter the bug ID in the Search For field.

• To search for bugs based on specific criteria, enter search criteria, such as a problem description, a 
feature, or a product name, in the Search For field.

• To search for bugs based on products, enter or select a product from the Product list. For example, 
if you enter “WAE,” you get several options from which to choose.

• To search for bugs based on releases, in the Releases list select whether to search for bugs affecting 
a specific release, bugs that were fixed in a specific release, or both. Then enter one or more release 
numbers in the Releases field.

Step 4 When the search results are displayed, use the filter tools to narrow the results. You can filter the bugs 
by status, severity, and so on.

To export the results to a spreadsheet, click Export Results to Excel.

Known Limitations
This section describes known limitations and restrictions for Cisco WAE.

CSCvh53464 The Bandwidth on Demand application connection fails because of an XTC "invalid request; no handler 
registered" error.

CSCvh53663 Old demands are not cleared when WMD runs demand mesh.

CSCvi70977 Installer shows a syntax error in the script.

Table 1 Open Bugs (continued)

Bug ID Description
17
Cisco WAN Automation Engine Release Notes, Release 7.1

https://bst.cloudapps.cisco.com/bugsearch/bug/CSCvh53464
https://bst.cloudapps.cisco.com/bugsearch/bug/CSCvh53663
https://bst.cloudapps.cisco.com/bugsearch/bug/CSCvi70977
http://tools.cisco.com/bugsearch
http://tools.cisco.com/RPF/register/register.do
https://tools.cisco.com/bugsearch
https://tools.cisco.com/bugsearch
http://tools.cisco.com/RPF/register/register.do
http://tools.cisco.com/RPF/register/register.do


   

Known Limitations
WAE System

Startup

The $CARIDEN_HOME directory is not automatically added to $PATH. (Only $CARIDEN_HOME/bin is.) To 
start the WAE Design GUI from the command line when it is not under $CARIDEN_HOME/bin, you must 
specify its full path: /opt/cariden/software/mate/current/mate.

License Check Failures on Newer Linux Distributions

Some newer Linux distributions use a new way (using biosdevname) of naming hardware devices, 
including network interfaces. This causes some software that depends on the traditional naming (for 
example, eth0, eth1) to fail on license checks.

The workaround is to append biosdevname=0 to the kernel line of the grub configuration file and reboot. 
(Syntax varies among distributions.)

After reboot, you should be able to use ifconfig to verify that the NICs are named eth0 (or eth1, ...) 
instead of the biosdevname names (such as p34p1).

NetFlow Collection
NetFlow collection is not supported on Alcatel-Lucent devices.

WAE Optical Plug-In
The optical plug-in (optical-nimo) is supported on Oracle JRE 1.8 but not on OpenJDK JRE. Oracle JRE 
1.8 is not packaged with WAE 7.1. You can download Oracle JRE 1.8 from Oracle’s website.

If you are using a JRE other than Oracle JRE 1.8 for other Java programs and you want to use the optical 
plug-in, you must download Oracle JRE 1.8 and add the following lines to the beginning of the 
<WAE_installation_directory>/packages/optical-ctc-plugin/run.sh file:

#!/bin/bash
export JAVA_HOME=<path_to_JRE_installation_directory>
export PATH=$JAVA_HOME/bin:$PATH

WAE Design
• macOS Sierra 10.12 and later implements an additional security measure for applications that are 

not distributed through the App Store; this includes WAE Design.

By default, WAE Design is in a quarantine state as shown by the following command on a terminal:

xattr wae_design.app

The command returns the following output for a quarantined application:

com.apple.quarantine

As a workaround, remove WAE Design from quarantine by entering the following command in the 
directory where WAE Design is installed:

xattr -r -d com.apple.quarantine wae_design.app
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Known Limitations
You can now run WAE Design 7.1 from macOS Sierra 10.12 and later.

• If you are using macOS X 10.12 or later with the WAE Design GUI and the Parse Configs tool 
(File > Get Plan from > Configs), add the following lines in ~/.bash_profile:

launchctl setenv JAVA_HOME `/usr/libexec/java_home -v 1.8`
export JAVA_HOME=$(/usr/libexec/java_home -v 1.8)

FlexLM License Server
You cannot run the floating license server on a setup (Linux VM or actual host) that uses bonded virtual 
interfaces (that is, a setup with multiple interfaces that have the same MAC address but different IP 
addresses within a VM). If the WAE Design client tries to check out a license from a setup that uses 
bonded virtual interfaces, the license checkout fails with the error "No license found."

As a workaround, run the floating license server in a standard Linux VM or host.

WAE Collection
• Due to vendor MIB limitations, WAE cannot represent QoS traffic on interfaces that have more than 

one VLAN configured. If a network contains such interfaces, their queue traffic statistics are omitted 
from the collection. The total traffic on these interfaces is still measured. As a result, demands for 
every class of service estimated through Demand Deduction are less accurate. Estimates of traffic 
totals over all classes of services, however, are not affected.

• Due to lack of MIB support, SR tunnel type is not collected for Cisco IOS XR routers through 
SNMP.

• Collection of interface egress shaping rate for Alcatel-Lucent devices does not support LAG 
interfaces.

• Juniper MIBs do not support P2MP LSPs.

• OSPFv3 and IPv6 IS-IS databases cannot be collected.

• WAE cannot associate a GRE tunnel with the physical interface it uses to reach the tunnel 
destination because the IP-Tunnel MIB lacks this information.

• For Juniper routers: Signaled standby LSP option is not available from the standard MPLS-TE MIB. 
Only the active path option name is collected.

• For Cisco IOS XR routers:

– IGP topology collected through topo-igp-nimo module:

– IS-IS link-state database with TE extensions contains incorrect interface “admin-weights” 
(TE metric) on Intel-based routers.

– IPv6 IS-IS link-state database does not contain IPv6 interface addresses or parallel interfaces. 
This information is only available when Cisco IOS XR supports IS-IS IPv6 TE extensions.

– MAC Accounting is not supported.

– The lsp-snmp-nimo module does not set the Standby value in the <LSPPaths> table for signaled 
backup paths or collect named affinities configured with affinity-maps.

• BGP peers:

– The topo-bgp-nimo module does not build BGP pseudo-nodes among internal ASNs.
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Accessibility Features
– The topo-bgp-nimo module does not collect BGP peers under PE-CE VRFs.

• TE Extended Admin Groups (EAGs), also known as extended affinities, are only supported from 
Juniper and parse_configs.

• There is no support for building port circuits for LAG members that are not within the same IGP 
(inter-AS circuits).

• It is not possible to distinguish between physically connected and unconnected LAG ports that are 
down for LAG port matching.

• The topo-igp-nimo module cannot be used when routers have a large number of links that cannot fit 
into a single PDU.

• With segment routing, concurrent RSVP-TE and SR-TE paths are not supported on the same LSP.

Accessibility Features
For a list of accessibility features in Cisco WAE, visit Cisco's Voluntary Product Accessibility Template 
(VPAT) website, or contact accessibility@cisco.com.

All product documents except for images, graphics, and some charts are accessible. If you would like to 
receive the product documentation in audio format, braille, or large print, contact 
accessibility@cisco.com.
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